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by Ken Appel, John Gastineau, Clarence Bakken, and David Vernier

■
■
■
■
■
■
■
■
■
■
■
■
■
■
■
■
■

Physics with Computers is now shipping. This book provides 34
ready-to-use labs for physics teachers using our Universal Lab
Interface and Logger Pro™ software. The experiments included are

Graph Matching
Back and Forth Motion
Modern Galileo Experiment
Determining g on an Incline
Picket Fence Free Fall
Ball Toss
Bungee Jump Accelerations
Projectile Motion
Newton’s Second Law
Atwood’s Machine
Newton’s Third Law
Static and Kinetic Friction
Air Resistance
Pendulum Periods
Simple Harmonic Motion
Energy of a Tossed Ball
Energy in Simple Harmonic Motion

■
■
■
■
■
■
■
■
■
■
■
■
■
■
■
■
■

Work and Energy
Momentum, Energy and Collisions
Impulse and Momentum
Sound Waves and Beats
Tones, Vowels and Telephones
Mathematics of Music
Speed of Sound
Ohm’s Law
Series and Parallel Circuits
Capacitors
The Magnetic Field in a Coil
The Magnetic Field in a Slinky
Electrical Energy
Polarization of Light
How Light Intensity Varies with Distance
Newton’s Law of Cooling
The Electronic Thermometer

Like our Chemistry with Computers, Biology with Computers, and Physical Science with Computers books,
this book has a lot of features that should be of help to teachers, including:
■ Ready-to-copy lab sheets for student use.
■ Experiment files for each lab, with pre-set graphs, data collection parameters, calibrations, and

notes for the students.

BITS & BYTES

■ Word processing files of the student handouts so that you can edit them for your specific lab

WORKSHOPS

■ Teacher’s guide with suggestions, sample results, and graphs.
■ A free high school or college department site license with each book purchased.
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situation (Microsoft Word format).

Physics with Computers (includes 280-page book and two disks)
For use with Logger Pro (Windows or Power Macintosh) ........................ PWC-LP ..................... $35.00
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CBL News
by Rick Sorensen
Flash Technology from Texas Instruments

College Physics with the CBL and TI-86

Texas Instruments recently announced a significant
improvement in the design of calculators. Until now, TI
graphing calculators only contained RAM, which is used to
store programs, data collected with a CBL or CBR, variables,
and functions. The newest calculators now also contain Flash
ROM. Flash ROM is additional memory that is used to store
applications, data, and programs. The most important feature
of Flash ROM is that it allows you to update the software on
your calculator. This means you will be able to electronically
upgrade your calculator as new software becomes available.

by John E. Gastineau
We now carry a new TI publication called College Physics with
the CBL and TI-86 written by John Gastineau. This set of
student laboratory activities uses the TI-86, CBL, Vernier
sensors, and our PHYSICS program to collect and analyze data.
The book contains 30 activities in mechanics, sound, light,
electricity, and magnetism. Even though the book was written
for introductory college and university courses, many high
school teachers will find it a valuable resource. The book costs
$20 (order code TI-CP). As some of you may know, John
Gastineau has been working as a consultant for Vernier
Software for the past year. He has helped us with our Logger Pro
software and is a co-author of our new Physics with Computers
lab manual. His next project for us will be Physics with CBL.

TI-73
If you teach middle grades, the new TI-73
could be your best choice in graphing
calculators. This calculator combines
the fraction capabilities of the Math
Explorer, and the scientific and trig
functions of the Explorer Plus, with the
features of a graphing calculator. Since
the calculator has a large screen, students
can explore patterns, create a variety of
charts (including bar charts, pie charts, and
pictographs) and analyze CBL or CBR data.
The TI-73 is CBL and CBR compatible, and it
comes with a basic CBL/CBR program in Flash ROM. This
summer we will convert our CHEMBIO and PHYSICS programs
to the TI-73. We will also make our Physical Science with CBL
compatible with the calculator. The TI-73 will be available in
July and will sell for $90 (order code TI-73).

TI-92 Plus Module
The TI-92 Plus Module is a plug-in module that replaces the
existing memory module in a TI-92. This module provides you
with 500K more memory, including an additional 128K RAM
and 384K Flash ROM. The module comes with Advanced
Mathematics Software, which adds advanced analysis features
for college-level math, science, and engineering. These features
include numeric differential equation graphing, improvements
in symbolic expression formatting, real-time rotation of 3-D
surfaces, unit conversions, and support for units in equations.
The TI-92 Plus Module will sell for $75 (order code TI-92MOD)
and will be available in July.
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Holt Physics
by Dr. Raymond Serway and Dr. Jerry Faughn
This spring, Holt, Rinehart, and Winston
announced their new high school physics
program, Holt Physics, by Serway and
Faughn. While developing the labs for the
text, Holt decided to incorporate
technology in a number of the
experiments. In 12 of the 26 labs, teachers
can choose between a traditional lab and
a lab incorporating graphing-calculator
technology. The graphing-calculator experiments use the CBL
with the TI-82 or TI-83, along with Vernier sensors and our
PHYSICS program. CBL labs appear in chapters on mechanics,
gas laws, heat, sound, light, electric circuits, and magnetism.
The book also uses the graphing calculator in a series of articles
entitled “Technology and Learning.” For more information,
visit the Holt, Rinehart, and Winston web site at www.hrw.com
or call 1-800-HRW-9799.

CBL Programs on the Web
Since our PHYSICS and CHEMBIO programs are being used
more and more, we have made it easier to get them from
our web site, www.vernier.com. Until now, you would
download one file that contained all of our programs for all
the calculators. Now you can also be selective and
download programs for specific calculators. To check it out,
visit our site and click the link to “Free Stuff.”
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Logger Pro Upgrades
If you own Logger Pro for a Windows 95 or Windows NT 4.0
machine, you can download a file from our web site that will
upgrade your software to the latest version. Before you try to
download the upgrade, you need to know which version of
Logger Pro you are running. The easiest way to determine this is
to start the program and note the version number on the
splash screen that is displayed during startup. If you are already
running Logger Pro, you can find the version number by
choosing the About Logger Pro option from the Help menu.
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AAPT Photo Contest
The 1998 AAPT High School Physics Photo
Contest is open to any high school student.
Photos must be 8x10, in black and white or color. A paragraph
(<250 words) describing the physics involved in the photo
must be included. Photographs will be judged by physics
teachers attending the summer AAPT meeting in Lincoln, NE.
Vernier Software supplies the prizes. For more information,
contact Ann M.W. Brandon, Joliet West High School, 401 N.
Larkin Ave., Joliet, IL 60435.

To download the update from our web site, click the link to
Free Stuff, which can be found in the left column of the main
page. The Freebies, Demos, and Program Update page will
come up. Click the link to Logger Pro Updates. Next, click on
the link that corresponds to the exact upgrade you are making;
e.g., version 1.0.3 to 1.0.6. A “patch” file will be loaded onto
your computer. After downloading the patch file, double click
on it. You will be asked to locate the existing Logger Pro
software. If you used the default settings during the initial
installation, your existing software is in the Logger Pro folder,
which can be found in the Vernier Software folder of My
Programs. If you did not use the default settings during
installation, you will need to locate the folder in which Logger
Pro was installed. Once you choose the correct folder, your
software will be updated to the newest version.

What’s new @ www.vernier.com?

If you do not have Internet access or if you are running
Windows 3.x, contact us to get the upgrade in disk form.

■ Free Logger Pro upgrades.

If you haven’t seen it lately, you should check out our web site.
It has been around since the spring of 1995. As the internet
becomes more and more popular, we will continue to add to
our site. In addition to all of the information in our 1998
catalog, you will find
■ Free CBL data collection programs for all TI calculators.
■ Two sample labs from each of our lab manuals.
■ The latest info on all of our workshops and conferences.
■ Technical specifications on all of our sensors.
■ Frequently Asked Questions (FAQs).
■ Demo versions of our most popular programs.
■ Updated experiment files for all of our programs.
■ New product announcements.
■ Past issues of this newsletter.

We keep adding features to
Logger Pro. Last fall, we added
support for Rotary Motion
Sensors and Photogates. The
latest addition is support for
Radiation Monitors. You can
now do studies of half life,
shielding, and the inverse
square law using Logger Pro.
Sample results taken with
Logger Pro, a ULI, and our Student Radiation Monitor (order
code SRM-DG) are shown here.
The Power Macintosh version of Logger Pro will be available at
the end of May. It will allow Power Mac users to gain some
new features over our existing Macintosh programs, including
■ using four analog inputs at the same time.
■ using two motion detectors at the same time (requires

ULI II EPROM 1.2 or newer).
We will continue to support and sell our existing Macintosh
programs (Data Logger, MacMotion, Sound, etc).

We recommend that you put www.vernier.com on your list of
favorite sites and check it periodically to keep up to date on
our products.

Science
Humor
Here is some science-related humor from the annual joke
contest from “Prairie Home Companion” on National Public
Radio.
■ “He is so dense that light bends around him.”
■ “An optimist sees a glass as half full. A pessimist sees the

same glass as half empty. An engineer sees it as a glass that
is twice as big as it needs to be.”
And here is a really obscure one. (If you do not get it, ask a
computer scientist.) “Why is Halloween like Christmas?”
OCT 31 = DEC 25
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Using Vernier Sensors
for Water-Quality Studies
by Dan Holmquist and Scott Holman
With the introduction of our new Vernier Ion-Selective
Electrodes, we decided it was time to do a trial water quality
study in the greater Portland, Oregon area. Our choice was the
Tualatin River, a medium-sized river that flows about 100 miles
from the Coastal Range
west of Portland to its
eventual confluence with
the Willamette River near
the center of Portland.
We collected water
samples at four locations
on April 24th at the
following locations:

significant part of total dissolved solids is usually due to either
hard-water ions (e.g., Ca2+, Mg2+, Fe3+, or HCO3-), or salts
dissolved from the stream bed (e.g., Na+ or Cl-), we made
measurements of the Ca2+ and Cl- concentrations (using the
Vernier Calcium ISE and Chloride ISE). Here are the results:

■ Site 1: After the river flows from the heavily-forested Coastal

Range
■ Site 2: After the river meanders through agricultural land for

15 miles
■ Site 3: After the river has gone through more agricultural

land and residential suburbs
■ Site 4: After the river flows several more miles through

populated suburbs of Portland
Measurements were made at each site using a portable CBL
and TI graphing calculator. We also made use of a PC laptop
computer using a Serial Box Interface (with a Rechargeable
Battery Pack). We made other measurements soon after
returning from the trip (nitrate, calcium, chloride, ammonium,
conductivity). Even though the levels of several of these ions in
the Tualatin River water were as low as 1 mg/L (1 part per
million), the new ion-selective electrodes provided very stable,
reproducible results. Here is a summary of some of the
measurements:

Calcium, Ca2+

Chloride, Cl-

The results indicated a gradual increase in the Ca2+ and Cl- ion
concentrations throughout the four sites. As is typical for
western Oregon water, water hardness is very low; the highest
Ca2+ concentration (17.3 mg/L) would correspond to a
Calcium Water Hardness value of 44.0 mg/L, a value
considered “very soft water.” The highest chloride
concentration (8.1 mg/L) is far below the EPA chloride
drinking water standard of 250 mg/L.
Because the Tualatin River flows through agricultural areas
between sites 1 and 3, and flows through populated areas
(between sites 3 and 4), we thought it might be interesting to
see how nitrate (NO3-) and ammonium (NH4+) levels were
affected. Here are the results of each of these tests:

■ As expected, temperature increased from site 1–4 (9.5, 12.1,

13.3, and 13.3° C).
■ The pH values, measured using a Vernier pH System,

hovered very close to a value of 7, which is typical for
western Oregon water (7.12, 6.99, 7.01, and 7.04).
■ The Conductivity Probe revealed that the level of total

dissolved solids (TDS) increased significantly from site 1–4
(32.2, 41.1, 56.0, and 64.6 mg/L TDS, respectively).
Since the conductivity tests showed a steady increase in ion
concentration of the stream, we were quite curious to see the
results of our tests using our ion-selective electrodes. Because a
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Ammonium, NH4+
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There is a noticeable increase in both nitrate and ammonium
ion concentrations. These may be due to runoff of fertilizers
from farm fields between sites 1 and 3. Stream flow drops
significantly after site 1, so decomposition of biological matter
may contribute to the increased levels of nitrate ions. Water
with nitrate levels less than 1 mg/L are generally considered to
be “unpolluted,” while levels higher than 10 mg/L are unsafe
for drinking water. The peak nitrate level of 2.53 mg/L at site 4
is moderately high.
We also made dissolved oxygen measurements using the Vernier
Dissolved Oxygen Probe. This small decrease in dissolved
oxygen concentration shown below may be due to an increase
in biological decomposition in the stream.

Dissolved Oxygen Concentration
The purpose of this article is to show how easily data can be
collected using a variety of Vernier sensors and portable data
acquisition systems. Your students can experience the same kind
of excitement we did while investigating a local lake or stream.
The following sensors were used in our experiments:
Sensor

Order Code

Price
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Innovative
Uses
Dewey Beadle (Seneca HS, Louisville, KY) has been using our
Apple II products for many years. His students are still doing
quality science experiments with the Apple IIs. Here are some
sample graphs showing force vs. time for collisions between a
cart and a mounted force sensor. The left graph is a collision
with no padding and the right graph is a collision with a foam
bumper.

Mary Pat Evans (The Londonerry School,
Harrisburg, PA) sent us information
about her 8th-grade student, Jessica
Lyons, who recently entered a science fair
with a project on monitoring the purring
of cats. Jessica used a ULI and microphone. Her original
hypothesis was that the volume would increase when the cat
was petted. In fact, she discovered that the frequency of the
purring also increases when the cat is petted.

ISE Amplifier ................................. ISE-DIN............................ $39
Ammonium ISE ............................ NH4-ISE ......................... $149
Calcium ISE ................................... CA-ISE ............................ $149
Chloride ISE .................................. CL-ISE ............................ $149
Nitrate ISE ..................................... NO3-ISE......................... $149
pH System ..................................... PH-DIN ............................ $72
Conductivity Probe ....................... CON-DIN ........................ $79
Extra Long Temperature Probe ..... TPL-DIN ........................... $68
Dissolved Oxygen Probe .............. DO-DIN ......................... $189

Ten Years Ago in this Newsletter . . .
We announced our first version of Precision Timer for
MS-DOS computers. Also included was a report on Laser 128
compatibility and a review of our book How to Build a Better
Mousetrap and 13 Other Science Projects Using the Apple II.

Jerry Easdon (College of the Ozarks) and his student, Scott
Deken, sent us data collected from a ride on the Ozark
Mountain Skycoaster. The ride is like the giant swings you may
have seen at other amusement parks. The graph above shows
the total acceleration calculated as the vector sum of three
accelerations measured with our 3-Axis Accelerometer (order
code 3D-DIN).
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Bits & Bytes
Vernier in Print
There have been a lot of articles in
recent physics journals about
experiments and demonstrations using
our sensors and software. Here are some
that you may want to look up:
Measuring the Forces Required for Circular
Motion by Charles Henderson
(Macalester College), The Physics Teacher,
Feb 1998. Measures centripetal force
using our Dual-Range Force Sensor
mounted on an easy-to-build device.
Another Use for the Sonic Ranger by James
C. Kernohan (Milton Academy), The
Physics Teacher, Feb 1998. Students make
predictions about what they would
expect on energy graphs and then test
their predictions with the motion
detector.
The 100-Meter Dash: Theory and
Experiment by Glenn Wagner (Centre
Wellington District HS, Fergus, Ontario),
The Physics Teacher, Mar 1998. Students
use Graphical Analysis to analyze data
on sprinter’s performances and compare
with a mathematical model.
Milkweed Seed Dispersal: A Means for
Integrating Biology & Physics by Gregory
D. Bisbee and Cheryl A. Kaiser
(Arrowhead HS, Hartland, WI), The
American Biology Teacher, Sept 1997.
Students study the range of dispersal of
seeds as a function of wind speed and
use Graphical Analysis for analysis.
Force Exerted by a Chain by Willem H.
van den Berg (State College Area HS,
State College, PA), The Physics Teacher,

Jan 1998. Students use a CBL and force
sensor to measure the force exerted and
compare it to mathematical models.
Assessing Student Learning of Newton’s
Laws: The Force and Motion Conceptual
Evaluation and the Evaluation of Active
Learning Laboratory and Lecture Curricula
by Ronald K. Thornton (Tufts
University) and David R. Sokoloff
(University of Oregon), American
Journal of Physics, April 1998. Compares
student results after traditional physics
instruction and after active learning,
including the use of MBL. Also includes
the complete force and motion
conceptual evaluation, which you may
want to use with your classes.
Sensing Subtle Tsunamis - The Amateur
Scientist by Shawn Carlson, Scientific
American, May 1998. Our Serial Box
Interface is recommended as a low-cost
way to log the data on a PC or a
Macintosh computer from a
microbargraph and other home-made
devices.
Logger Pro was favorably reviewed in the
March, 1998 issue of Technology and
Learning.
A Microcomputer-Based Phase-Change
Experiment by Francis X. Hart, University
of the South, Sewanee, TN, The Physics
Teacher, Feb 1998. In this experiment,
students monitor the temperature of a
beaker of Crisco shortening as it cools.
At the same time, they monitor the light
transmission through it. When the
phase change occurs, there is a big
change in the light transmission.

The Caliper is published semiannually by Vernier Software.
It is distributed free of charge to Vernier Software customers.
Apple II and Macintosh are registered trademarks of Apple Computers, Inc.
IBM is a registered trademark of International Business Machines Corp.
MS-DOS, Microsoft and Windows are registered trademarks of Microsoft Corporation.
Calculator-Based Laboratory, CBL, Calculator-Based Ranger, CBR, and TI-GRAPH LINK
are trademarks of Texas Instruments, Inc.
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Graphical Analysis
for Windows
Several people have complained about
the fact that Graphical Analysis for
Windows always tries to use the wrong
COM port when importing data from a
TI calculator or CBL. Here is the way to
permanently change the setting:
■ Choose Import from TI calculator
■
■
■

■

from the File menu as usual.
Click on the option to Select Port.
Select the proper COM port and click
on OK.
Import some data from a calculator,
just to make sure you have the right
port.
Choose Save As from the File menu
and save the file with the exact name
Startup.dat. This is the file that is
automatically loaded each time you
start Graphical Analysis.

Grants and Donations
We are often asked for advice on how to
find funding for technology. We would
like to pass along some of the tips, tricks,
and strategies of our loyal Caliper
readers. Have you recently won a grant
for technology in your school? Do you
have any advice for others who want to
write a grant proposal or inquire about
corporate donations? Please send us an
e-mail (info@vernier.com), and let us
know how you got your grant or
donation. We would like to start a new
section on our web site with tips, tricks,
and links to useful resources for schools
in need of funding.

Vernier Software
8565 S.W. Beaverton-Hillsdale Hwy.
Portland, OR 97225-2429
Phone (503) 297-5317 FAX (503) 297-1760
info@vernier.com • www.vernier.com
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Evaluation Workshops
Leadership Modeling Workshops
Exceptionally motivated high school physics teachers
nationwide who wish to contribute to science-teaching reform
are invited to apply for the final series of NSF-funded
Leadership Modeling Workshops. Workshops will be held for
four weeks in each of the next two summers at Univ. of MD
(June 29 - July 24), Univ. of Central FL (June 29 - July 24), or
Univ. of CA at Davis (July 6 - 31) in 1998 and 1999.
Participants will receive a $1200 stipend, plus travel, housing
and meal allowance. Graduate credit is available. Teams okay.
Seventy-five teachers will learn the modeling method of
instruction, which corrects weaknesses of the traditional
lecture-demonstration method, including the fragmentation of
knowledge, student passivity, and the persistence of naive
beliefs. MBL and/or CBL techniques are used. For information,
contact Reba Wilson, Box 871504, Dept. of Physics, Arizona
State University, Tempe, AZ 85287-1504; (602) 727-6199;
reba@asu.edu; http://modeling.la.asu.edu/modeling.html.

Oceanology for Educators
A three-day workshop titled Oceanology for Educators will be
offered June 24-26 at Schaefer Oceanology Wet Lab in Marion,
MA. Among the workshop activities, they will do water quality
testing using our sensors. For information, contact Susan
Nourse at 617-628-5000 x 5394, snourse@emerald.tufts.edu.

Workshop Science
Workshop Science is a new physical science course now being
developed. It is similar in style to the Workshop Physics
curriculum that many of you use. The authors would like to do
additional classroom testing of the unit on energy. This unit
uses several of our sensors, including our CO2 Gas Sensor. For
information, contact Priscilla Laws, Physics Department,
Dickinson College, P.O. Box 1773, Carlisle, PA 17013,
lawsp@dickinson.edu.

T3–Teachers Teaching with Technology
The Teachers Teaching with Technology (T3) organization
provides an excellent way to learn more about the use of
graphing calculators in science and math through national
conferences and hundreds of summer workshops. Eighteen
CHEM/BIO and 32 Connecting Math and Science workshops
will be held in various cities across the country. For more
information, contact Teachers Teaching with Technology,
P.O. Box 650311, MS 3908, Dallas, TX 75265, (888) 2-TCUBED,
t-cubed@ti.com.

We will be demonstrating the use of Vernier hardware and
software in the classroom at the following locations during
1998. Join us for an evening in which you can learn how to
integrate our data-collection software, interfaces, and sensors
into your classroom. These workshops are free of charge.
September 10:
September 21:
September 24:
September 28:
September 29:
October 6:
October 12:
October 22:
October 27:
October 29:

Rochester, NY
Providence, RI
Philadelphia, PA
Norfolk, VA
Cleveland, OH
Columbia, SC
Tallahassee, FL
Baton Rouge, LA
Houston, TX
Dallas, TX

Computer or CBL
Workshops—Portland, OR
We will be offering five one-day workshops at Vernier
Software in Portland, Oregon. Participants will receive
intensive training in computer or CBL data collection.
Combine this experience with a trip to the scenic Pacific
Northwest. The fee for each workshop is $50. At the
workshop, you will receive a $50 gift certificate good
towards the future purchase of any products in the Vernier
Software catalog.
■ July 20–Using the TI-82/83 with the CBL system
■ July 21–Using the TI-82/83 with the CBL system
■ July 22–Using the TI-82/83 with the CBL system
■ July 23–Collecting data using Windows and

Macintosh computers
■ July 24–Collecting data using Windows and

Macintosh computers

■
You may register for our workshops by phone, mail,
electronically at www.vernier.com, or by e-mail at
workshop@vernier.com. Contact Amy Ring at
(503) 297-5317 for more information.
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UPCOMING
EVENTS

Albuquerque
Corpus Christi

We will be exhibiting at all of the following conferences. If you attend, stop by and say hello.
National Education Computing Conference ........................................................ San Diego, CA .............................. June 22-24
AAPT Summer Meeting ................................................................................................ Lincoln, NE .............................. August 3-8
15th Biennial Conference on Chemical Education ......................... Waterloo, Ontario, Canada ............................ August 9-13
California Science Teachers Association .................................................................... San Jose, CA .......................... October 8-10
Oregon Science Teachers ........................................................................................... Portland, OR ............................... October 9
New Jersey Science Teachers ...................................................................................... Somerset, NJ ........................October 13-14
Illinois Science Teachers Association ....................................................................... Rosemont, IL ........................October 16-17
NSTA Northwestern Area Convention .........................................................................Seattle, WA ........................October 29-31
Virginia Association of Science Teachers ............................................................... Richmond, VA ........................October 30-31
New York Science Teachers ...................................................................................... Ellenville, NY ........................ November 1-3
North Carolina Science Teachers ........................................................................ Greensboro, NC ........................ November 4-6
National Association of Biology Teachers ......................................................................Reno, NV ........................ November 5-7
Science Teachers Association of Ontario ............................................ Toronto, Ontario, Canada ........................ November 5-7
American Mathematical Association of Two-Year Colleges ....................................Portland, OR ........................ November 5-8
Texas Science Teachers, CAST ........................................................................... Corpus Christi, TX ................... November 19-21
NSTA Southern Area Convention ....................................................................... Birmingham, AL ................... November 19-21
NSTA Southwestern Area Convention ............................................................. Albuquerque, NM ........................ December 3-5
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